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例題4. 單跨拱橋 
 

 

 

  概要 

 

此例題將介紹利用 midas Civil 對有車輛載重作用的單跨拱橋進行建模、結構分析

及結果驗證的方法。 

 

在此省略了“例題1”中所介紹的 midas Civil 的一些基本功能，且本例中主要採

用圖示功能表。對 midas Civil 的功能或結構分析過程若有不解之處，請參考 

On-line Help 的說明。  

 

此例題所介紹的各階段分析步驟如下： 

 

1. 開啟新檔並設定建模環境 

2. 輸入構件的材料和斷面資料 

3. 輸入節點和單元 

4. 輸入建築物的邊界條件 

5. 輸入車輛移動載重與靜力載重 

6. 執行結構分析 

7. 查看分析結果 
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分析模型與載重條件  

 

本例題拱橋的模型如圖1所示，其基本情況如下。 

 

 橋樑形式  : 拱橋 

 橋樑等級  : 1等橋樑 

 跨     徑  : 50m 

 設計車道數 : 2條車道 

 橋     寬  : 14m 

 

 

 

          圖1.  分析模型資料 
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結構的平面如下所示。（參考圖2） 

 

 橫繫梁按 5m 間距排列 

 按橋樑軸方向設置縱向斜撐 

 在中心線兩端 7m 的位置設置主樑和拱肋 

 

 

 

 

 

 

 

 

 

 

 

(a) 平面圖 

 

 

 

 

 

 

 

(b) 立面圖 

圖2.  拱橋的平面圖和立面圖 
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對於載重條件，為了簡化問題只考慮以下 3 種條件。 

 

 載重條件 1 : 靜載重  90 kN/m （只作用於主樑） 

 載重條件 2 : 人行道載重 6 kN/m （只作用於主樑) 

 載重條件 3 : 車輛移動載重  

Taiwan, HS20-44(MS 18) ; HS-20-44(MS 18) 

衝擊力係數(Impact Factor)： 

         

I =
15.24

𝐿 + 38.1
=

15.24

50 + 38.1
= 0.173 

 

本例題的主要目的是為了介紹 midas Civil 的各項功能操作方法，因此有些條件會

與實際情況有出入，例題僅作為參考用。  
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    開啟新檔及設定基本操作環境 

 

選擇  New Project 開啟新檔，並選擇  Save 輸入檔案名稱存檔。 

 

在畫面下方的狀態列點擊單位選擇鍵( )選擇 ‘kN’ 和 ‘mm’。該單位系統可以根

據輸入資料的種類依照使用者需求任意進行變更。  

 

在此例題中為了提高操作上的熟練度，在建模過程中儘量不使用樹形選單或主選單，

而是以使用圖示選單（圖示工具列）為主。  

 

    

 

 

 

 

 

 

 

 

 

 

圖3.  模型視景配置 
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   輸入構件的材料與斷面資料 
 

本案例結構構件的材料和斷面資料如下。 

 

 材料性質(ASTM) 

1: A36 – 橫繫梁、斜撐構件 

 

2: A572-50 – 主樑、拱肋、吊桿 

 

 

 斷面資料 

1: Main Girder 主樑：BOX 21006001010  

 

2: Cross Beam 橫繫梁：I 15405001427  

 

3: Arch Rib 拱肋：BOX 6006001614  

  

4: Hanger 吊桿：I 6004001216  

 

5: Strut 斜支撐 & 橫向支撐：BOX 6005001014  

 

6: Bracing & Stringer 水平斜撐 & 縱梁：RH 4503041523 

 

 

斷面1~5 屬於焊接製作的斷面(Built-up Section)故可使用 User 功能輸入，而斷面6

則可使用程式中内建的CNS91標準斷面DB。 
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圖 4.  Properties 對話視窗 

  

 

 

 

 

 

 

              圖 5.  Material Data 對話視窗 

 

1. 主選單 Properties>Material Properties 

2. 點擊 Properties 對話視窗上方的 Material 表單 （如圖4. ） 

3. 點擊  鍵  

4. 在 General 的 Material ID 輸入欄內輸入 ‘1’ （如圖5. ） 

5. 在 Type 選擇欄中選擇 ‘Steel’   

6. 在 Steel 的 Standard 選擇欄中選擇 ‘ASTM(S)’


 

7. 在 DB 選擇欄中選擇 ‘A36’ 

8. 點擊  鍵  

9. 在 General 的 Material ID 輸入欄內輸入 ‘2’ 

10. 在 Type 選擇欄中選擇 ‘Steel’   

11. 在 Steel 的 Standard 選擇欄中選擇 ‘ASTM(S)’ 

12. 在 DB 選擇欄中選擇 ‘A572-50’ 

13. 點擊  鍵  

 

 

 

 

 使用者可事先在Tools 

>Preferences中設定規範

預設值。 

 

 
 
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 

 

1. 選擇  Properties 對話視窗上方（如圖4.）的  Section 表單（或主選單 

Property>  Section） 

2. 點擊  鍵  

3. 選擇 DB/User 表單並確認 Section ID 輸入欄內輸入 ‘1’  

4. 在 Name 欄位輸入 ‘Main Girder’ 


 

5. 在 Section Shape 選擇欄內選擇 ‘Box’ （如圖6. 的） 

6. 在 User 或 DB 選項選擇 ‘User’ 

7. 在 H 欄位輸入 ‘2100’ 

8. 在 B 欄位輸入 ‘600’ 

9. 在 tw 欄位輸入 ‘10’ 

10. 在 tf1 欄位輸入 ‘10’ 

11. 點擊  鍵 

12. 重覆步驟 3~11 建立斷面編號 2~5 (參考P2-6 所列斷面資訊) 

13. 確認 Section ID 輸入欄為 ‘6’ 

14. 在 Name 欄位輸入 ‘Bracing & Stringer’ 

15. 在 Section Shape 選擇欄內選擇 ‘I-Section’ （如圖6. 的） 

16. 在 User 或 DB 選項選擇 ‘DB’ 並確認選擇 ‘CNS91’  

17. 在 Sect. Name 選擇欄輸入 ‘RH 4503041523’ （或直接選取）


 

18. 點擊  鍵  

19. 點擊  鍵  

20. 在狀態列點擊單位選擇鍵（ ）將 ‘mm’ 改為 ‘m’ 

 

 

 

 

 

 

 

 

 

 

 

          圖 6.  Section Data 對話視窗 

 在Section 選擇欄輸入

構件名稱的第一個字母的

話，會自動顯示以該字母

為首的斷面列表，列表中

第一個斷面為該字母為首

的斷面中最重的斷面。  

 Name 是用來區分各種

材料的，與材料的性質無

關。在資料庫中選擇某種

材料時，名稱欄中會自動

被賦予被選擇的材料名

字。 
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    使用節點和單元建立模型 

 

建立拱肋 

利用 Structure Wizard 功能建立拱肋（參考圖7.）。                    

 

1. 主選單 Structure> Wizard>Base Structures>Arch 

2. 在 Input/Edit 表單的 Type 選擇欄確認 ‘Parabola1’


 

3. 在 Number of Segments 輸入欄確認 ‘10’  

4. 在 L 輸入欄輸入 ‘50’  

5. 在 H 輸入欄輸入 ‘10’  

6. 在 Boundary Condition 選擇欄選擇 ‘None’  

7. 在 Show Element No. 的左側表示 ‘’  

8. 在 Material 選擇欄選擇 ‘2 : A572-50’ 

9. 在 Section 選擇欄選擇 ‘3 : Arch Rib’  

10. 在 Insert 表單的 Insert Point 輸入欄確認 ‘0, 0, 0’  

11. 點擊  鍵  

12. 點擊  Auto Fitting 

13. 點擊  Front View  

 

 

 

 

 

 

 

 

 

 

 

      圖7.  Arch Wizard 對話視窗及拋物線形1 形式的概念 

 在 Input/Edit 表單的 

Type 選擇欄可以對拱的

形式 (投影等間距拋物

線、等間距拋物線、投

影等間距橢圓、等間距

橢圓)作選擇。在此考慮

吊桿的等間距排列，選

擇‘Parabola1’ 形式以使

拱肋上的節點投影到連

接兩端的直線上時為等

間距。(參考圖7.) 

x방향으로 등간격인 
포물선 아치를 형성하는 절점 

포물선 아치 

투영선 
投影線 

拋物線形拱 

X方向上的投影為等間距 
的拋物線形拱上的節點 
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建立垂直吊桿 

 

利用  Extrude Elements 功能將拱肋上生成的節點按垂直向下投影延長以輸入

吊桿。(參考圖9) 

 

1. 主選單 Node/Element>Element 點擊  Extrude Elements （圖8.的）


 

2. 點擊  Node Number (切換 on) 

3. 點擊  Select Window 選擇為建立吊桿要進行投影延長的節點 2~10  

4. 在 Extrude Type 選擇欄確認 ‘Node→Line Element’  

5. 在 Element Attribute 選擇欄的 Element Type 確認 ‘Beam’  

6. 在 Material 選擇欄選擇 ‘2 : A572-50’  

7. 在 Section 選擇欄選擇 ‘4 : Hanger’  

8. 在 Generation Type 選擇欄選擇 ‘Project’  

9. 在 Projection Type 選擇欄確認 ‘Project on a line’ 

10. 用滑鼠點擊 Base Line definition 的 P1 輸入欄使其變為草綠色後指定節

點 1 和節點 11


 

11. 在 Direction 選擇欄確認 ‘Normal’  

12. 點擊  鍵  

13. 點擊  Change Element Parameters （圖8.的）  

14. 點擊  Select Recent Entities （圖8.的）  

15. 在 Parameter Type 選擇欄選擇 ‘Element Local Axis’


 

16. 在 Mode 選擇欄確認 ‘Assign’ 與 ‘Beta Angle’ 

17. 在 Beta Angle 輸入欄輸入 ‘90’  

18. 點擊  鍵  

 

點擊  Shrink (圖9.的)和  Hidden (圖11.的)(切換 on)，可確認‘Beta角’

的輸入狀況。確認輸入狀態後，再次點擊  Shrink 和  Hidden 使其回到 

切換 off 狀態。 

 

 ‘定義基準線’是定

義被投影直線(Line)的輸

入欄，可透過輸入該直

線上的任意兩點來定

義。 

 擴展單元是將節點或

單元向任意位置移動並

沿著相應的移動路徑建

立高維單元的功能。

(如：節點→線單元,線單

元→面單元,面單元→實

體單元) 

 調整吊桿腹板軸的方

向使其與橋軸的垂直方向

一致。(參考圖9,On-line 

Manual 的“Civil的功能>

模型>修改單元參數” ) 
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圖 8.  產生垂直吊桿 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖 9. 調整吊桿的配置角度 ( Beta 角 )  

 

 

 

 

X 

Y 
Z 

X 
Y 

Z 

Beta Angle = 0° Beta Angle = 90° 

  

  
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形成拱橋的主樑並複製構架 

 

連接構架的兩端來輸入拱橋的主樑，並將所完成的一側構架複製到另一側。 

 

 

1. 點擊  Point Grid、  Point Grid Snap (切換 off)


 

2. 點擊  Iso View  

3. 主選單 Node/Element>  Create Elements  

4. 在 Element Type 選擇欄確認 ‘General beam/Tapered beam’  

5. 在 Material 選擇欄選擇 ‘2 : A572-50’  

6. 在 Section 選擇欄確認 ‘1 : Main girder’  

7. 在 Orientation 的 Beta Angle 輸入欄確認 ‘0’  

8. 在 Intersect 選擇欄確認 Node 左側的 ‘’ 

9. 用滑鼠點擊 Nodal Connectivity 輸入欄使其變為草綠色後指定節點 1 和

節點 11 

10. 點擊  Select All 

11. 點擊  Translate Elements (如圖10.的) 

12. 在 Mode 選擇欄確認 ‘Copy’ 

13. 在 Translation 選擇欄確認 ‘Equal Distance’ 

14. 在 dx, dy, dz 輸入欄輸入 ‘0, 14, 0’  

15. 在 Number of Times 輸入欄確認 ‘1’ 

16. 點擊  鍵 (參考圖10.) 

 

  

 因本例題不使用格

點，故為避免使用滑鼠

指定時出錯，將  格

點和  捕捉格點功能

設置為切換 off狀態。  
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圖 10.  完成主樑和拱形的模型 

 
 
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建立橫繫梁 

 

利用  Extrude Elements 功能將一側主樑上的節點擴展到另一側的主樑來建

立橫繫梁。 

 

1. 點擊  Extrude Elements (圖11.的) 

2. 點擊  Select Polygon 並選擇節點 1 和節點 11~20 

3. 在 Extrude Type 選擇欄確認 ‘Node→Line Element’  

4. 在 Element Type 選擇欄確認 ‘Beam’  

5. 在 Material 選擇欄確認 ‘1 : A36’  

6. 在 Section 選擇欄選擇 ‘2 : Cross beam’ 

7. 在 Generation Type 選擇欄選擇 ‘Project’ 

8. 在 Projection Type 選擇欄確認 ‘Project on a line’ 

9. 點擊 Base Line Definition 的 P1 輸入欄使其變為草綠色後指定節點 21 

和節點 31 

10. 在 Direction 選擇欄確認 ‘Normal’


 

11. 點擊  鍵  

 

 

 

圖 11.  建立橫繫梁  

 Project 功能的選

擇項目中，Direction

是指單元投影的方

向。 

 
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建立斜撐 

 

啟用(Activate)新建立的橫繫梁模型，利用 Element Snap 和  Create Elements

 功能來完成縱向斜撐（加勁肋條 Stringer）模型。  

 

1. 點擊  Select Recent Entities  

2. 圖示選單點擊  Activate 

3. 圖示選單點擊  Element Number (切換 on) 

4. 主選單 Node/Element>  Create Elements 

5. 在 Element Type 選擇欄確認 ‘General beam/Tapered beam’ 

6. 在 Material 選擇欄選擇 ‘1 : A36’ 

7. 在 Section 選擇欄選擇 ‘6 : Bracing & Stringer’  

8. 在 Orientation 的 Beta Angle 輸入欄確認 ‘0’  

9. 在 Intersect 選擇欄確認 Node 左側的 ‘’ Element 左側的 ‘’ 

10. 在畫面下端的狀態列，確認捕捉點的位置是否為1/2 (參考圖12.的) 

11. 用滑鼠點擊 Nodal Connectivity 輸入欄使其變為草綠色之後依次指定單元

 59 和 60 的中點 

12. 點擊  Element Number (切換 off) (參考圖12) 

 

 

圖12.  完成縱向斜撐  

 

 
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現在輸入橋面的對角斜撐。 

 

 

1. 選擇  Create Elements 功能 

2. 在視窗的 Element Type 選擇欄確認‘General beam/Tapered beam’ 

3. 在 Material 選擇欄確認 ‘1 : A36’ 

4. 在 Section 選擇欄確認 ‘6 : Bracing & Stringer’  

5. 用滑鼠點擊 Nodal Connectivity 輸入欄使其變為草綠色之後分別連接節

點 1 和  43 以及節點 43 和 21 輸入兩個單元 

6. 點擊  Translate Elements 

7. 點擊  Select Single 並選擇上面所建立的兩個斜撐單元 

8. 在 Mode 選擇欄確認 ‘Copy’  

9. 在 Translation 選擇欄確認 ‘Equal Distance’ 

10. 在 dx, dy, dz 輸入欄輸入 ‘5, 0, 0’  

11. 在 Number of Times 輸入欄輸入 ‘4’ 

12. 點擊  鍵  

13. 點擊  Mirror Elements  

14. 點擊  Select Previous、  Select Recent Entities 選擇所有對角斜撐

單元 

15. 在 Mode 選擇欄確認 ‘Copy’  

16. 在 Reflection 選擇 y-z plane，點擊 x 輸入欄使其變為草綠色之後指定

節點 16 （或在 x 輸入欄輸入 ‘25’） 

17. 點擊  鍵 (參考圖13.) 
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     圖13.  完成橋面模型 
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以拱肋的中央為基準輸入對稱排列於兩側的斜撐構件。  

 

 

1. 點擊  Inverse Activate (圖14.的) 


 

2. 點擊  Create Elements   

3. 在 Material 選擇欄確認 ‘1 : A36’  

4. 在 Section 選擇欄選擇 ‘5 : Strut’  

5. 在 Beta Angle 輸入欄確認 ‘0’  

6. 用滑鼠點擊 Nodal Connectivity 輸入欄使其變為草綠色之後，分別連接節

點 4 和 24、5 和 25、6 和 26、7 和 27、8 和 28 (參考圖14.)。 

 

 

 
 

圖14.  完成橋門斜撐 

 

 

 

 

 

 

 Inverse Activation

 是將目前處於啟用狀態

的節點和單元轉換為撤

銷啟用的狀態，而將處

於撤銷狀態的節點和單

元轉換為啟用狀態的功

能。  

 
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1. 點擊  Select Single，並選擇 5 個橋門斜撐單元 (單元111~115) 

2. 點擊  Activate 


 

3. 點擊  Element Number (切換 on) 

4. 在  Create Elements 對話視窗的 Element Type 選擇欄確認 ‘Gene

ral beam/Tapered beam’  

5. 在 Material 選擇欄確認 ‘1 : A36’  

6. 在 Section 選擇欄選擇 ‘6 : Bracing & Stringer’ 

7. 在 Orientation 的 Beta Angle 輸入欄確認 ‘0’  

8. 在 Intersect 選擇欄確認 Node 左側的 ‘’ 

9. 點擊 Nodal Connectivity 輸入欄使其變為草綠色之後，依次連接單元    

111~115 的中央來輸入縱方向的斜撐構件


 

10. 點擊  Element Number (切換 off) 

11. 點擊 Nodal Connectivity 輸入欄使其變為草綠色之後，依次指定節點 4

和53、24和53、5和54、25和54、54和7、54和27、55和8、55和28 (參考

圖15.)  

 

 

 

           圖15.  完成拱的斜撐 

 為建立拱中央的協

撐，只選擇與該單元相

連的部分並將其啟用。  

 輸入單元的過程中未

能正確選擇所需物件

時，可使用鍵盤上的Esc

鍵, 或點擊滑鼠的右鍵選

擇Context Menu下端的

Cancel功能表來取消輸

入內容。  
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    輸入結構的邊界條件 
 

建立完模型之後，需定義邊界條件(參考圖2.(a)的邊界條件)。 

 

1. 點擊  Activate All  

2. 在 Model Entity 表單選擇 Boundary 確認 ‘Supports’ (如圖16.) 

3. 在 Options 選擇欄確認 ‘Add’ 

4. 點擊   Select Single  

5. 選擇節點 ‘1’，在 ‘D-ALL’ 的左側表示 ‘’  

6. 點擊  鍵  

7. 選擇節點 ‘11’，只在 ‘Dy, Dz’ 的右側表示 ‘’  

8. 點擊  鍵  

9. 選擇節點 ‘21’，只在 ‘Dx, Dz’ 的右側表示 ‘’  

10. 點擊  鍵  

11. 選擇節點 ‘31’，只在 ‘Dz’ 的右側表示 ‘’ 

12. 點擊  鍵  

 

 

 

圖16.  輸入結構的邊界條件 

D-ALL 

Dx, Dz 

Dy, Dz 

Dz 
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輸入梁單元連接部的邊界條件  

 

使用 Beam End Release 功能按以下步驟輸入梁單元端部的邊界條件。(參考圖17) 

 

 吊桿構件的兩端 : 對單元座標系 z 軸為鉸接條件 

 斜撐構件的兩端 : 對單元座標系 y、z 軸為鉸接條件 

 與主樑相連接的橫繫梁兩端 : 對單元座標系 y、z 軸為鉸接條件 

  

1. 在 Boundary 功能目錄表內選擇 ‘Beam End Release’ 

2. 在 Options 選擇欄確認 ‘Add/Replace’  

3. 點擊 Filter 選擇欄 (圖17.的) 選擇 ‘z’


 

4. 點擊  Select All  

5. 在 General Types and Partial Fixity 選擇欄只對 i-Node、j-Node 的  

‘Mz’ 表示 ‘’


 

6. 點擊  鍵  

7. 點擊 Filter 選擇欄(圖17.的)選擇 ‘none’ 

8. 點擊  Select Identity-Elements (圖17.的) 

9. 在 Section 選擇欄選擇 ‘6 :Bracing & Stringer’  

10. 點擊  鍵  

11. 在 General Types and Partial Fixity 選擇欄點擊 Pinned-Pinned 鍵 (或

在 i-Node、j-Node 的 ‘My、Mz’ 選擇 ‘’) 

12. 點擊  鍵 

13. 點擊  Select Identity-Elements (圖17.的) 

14. 在 Section 選擇欄選擇 ‘2 : Cross beam’   

15. 點擊   鍵 

16. 在 Select Identity-Elements 對話視窗點擊選擇  鍵 

17. 點擊  Activate  

18. 點擊  Element Number (切換 on) 

19. 點擊 View>Select>  Select Intersect Line 選擇單元 59~69 


 

20. 在 General Types and Partial Fixity 選擇欄點擊 Pinned-Fixed 鍵  

21. 點擊  鍵  

 對Filtering Selection的

說明請參考線上幫助手冊

或Getting Started &     

Tutorials  

 欲確認單元座標軸時

可點擊  Display 選擇 

Element  表單的局部座

標。  

  Select Intersect

是用滑鼠任意畫一直線來

選擇與該直線相交的單元

的功能。  
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22. 在單元選擇輸入視窗 (圖17的) 輸入 ‘80to90’ 並按鍵盤上的 [Enter] 鍵 

23. 在 General Types and Partial Fixity 選擇欄點擊 Fixed-Pinned 鍵 

24. 點擊  鍵 

25. 點擊  Element Number (切換 off) 

26. 點擊  Activate All  

27. 點擊  Node Number (切換 off) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  圖17.  輸入梁端釋放條件 

  

 

 
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建立橫繫梁群組 
 

  為輸入車輛移動載重而建立橫繫梁群組。 

 

1. 點擊  Select Identity-Elements 

2. 在 Select Type 選擇欄確認 ‘Section’  

3. 在 Section 選擇欄選擇 ‘2 : Cross beam’  

4. 點擊  鍵 

5. 在 Select Identity-Elements 對話視窗點擊選擇  鍵 

6. 點擊樹形選單的  Group 表單 

7. 圖示選單點擊  Activate 

8. 圖示選單點擊  Top View、點擊  Select All 

9. 選擇 Structure Group 點擊滑鼠右鍵選擇 New 並輸入 ‘cross beam 1’ 

10. 由 Structure Group 選取 ‘cross beam 1’ 將其拖放到模型視窗進行指派  

 (圖18的)  

11. 點擊圖示選單  Activate All 、  Iso View 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖18.  建立橫繫梁群組 

 
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輸入車輛移動載重和靜力載重 
 

設定載重狀況  

 

輸入載重之前先設定載重狀況(Load Cases)。 

 

 

1. 主選單 Load>Static Load Cases 

2. 如圖19，在 Static Load Cases 對話視窗的 Name 輸入欄輸入 ‘Dead 

Load’  

3. 在 Type 選擇欄選擇 ‘Dead Load’  

4. 點擊  鍵  

5. 在 Name 輸入欄輸入 ‘Sidewalk Load’   

6. 在 Type 選擇欄選擇 ‘Dead Load’  

7. 點擊  鍵  

8. 點擊  鍵  

 

 

 

圖19. Static Load Cases 對話視窗 
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輸入靜力載重 

 

輸入靜力載重（載重狀況 1、2）。 

 

為了簡化問題，假定靜載重(90 kN/m) 和人行道載重(6 kN/m) 只作用於主樑之上。(參

考圖20.) 

 

1. 點擊  Select Identity-Elements  

2. 在 Select Type 選擇欄確認 ‘Section’  

3. 在 Section 選擇欄選擇 ‘1 : Main Girder’ 

4. 點擊  鍵  

5. 在 Select Identity-Elements 對話視窗點擊  鍵  

6. 主選單 Load>Element Beam Loads  

7. 在 Load Case Name 選擇欄確認 ‘Dead Load’  

8. 在 Options 選擇欄確認 ‘Add’  

9. 在 Load Type 選擇欄確認 ‘Uniform Loads’  

10. 在 Direction 選擇欄確認 ‘Global Z’  

11. 在 Projection 選擇欄確認 ‘No’  

12. 在 Value 選擇欄確認 ‘Relative’  

13. 在 x1 輸入欄輸入 ‘0’, x2 輸入欄輸入 ‘1’, W 輸入欄輸入 ‘-90’ kN/m 

14. 點擊  鍵  

15. 點擊  Select Previous  

16. 在 Load Case Name 選擇欄確認 ‘Sidewalk Load’  

17. 在 Options 選擇欄確認 ‘Add’  

18. 在 Load Type 選擇欄確認 ‘Uniform Loads’  

19. 在 Direction 選擇欄確認 ‘Global Z’  

20. 在 Projection 選擇欄確認 ‘No’  

21. 在 Value 選擇欄確認 ‘Relative’  

22. 在 x1 輸入欄輸入 ‘0’, x2 輸入欄輸入 ‘1’, W 輸入欄輸入 ‘-6’ kN/m 

23. 點擊  鍵  

24. 點擊  鍵  
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圖20. 載重輸入狀況 
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輸入車輛移動載重 

 

首先定義車道。(參考圖21)  

 

1. 主選單的 Load >Moving Load 

2. Moving Load code 對話視窗選擇‘Taiwan’  

3. 選擇 Moving Load Analysis Data>Traffic Line Lanes 

4. 在 Traffic Line Lanes 對話視窗點擊  鍵  

5. 在 Lane Name 輸入欄輸入 ‘Lane 1’ 

6. 在 Eccentricity 輸入欄確認 ‘-4.5’ m 

7. 確認 Wheel Spacing 為‘1.8’ m 

8. 在 Impact Factor 輸入欄輸入 ‘0.173’ 

9. 在 Vehicular Load Distribution 輸入欄確認 ‘Cross Beam’ 

10. 在 Cross Beam Group 輸入欄確認 ‘cross beam 1’ 

11. 在 Moving Direction 選擇欄確認 ‘Both’ 

12. 在 Selection 的 2 Points、Picking 及 Number 中選擇 ‘2 Points’，用滑

鼠點擊右側的輸入欄使其變為草綠色後，指定節點 1、11 


 

13. 點擊  鍵  

14. 在 Traffic Line Lanes 對話視窗點擊  鍵  

15. 在 Lane Name 輸入欄輸入 ‘Lane 2’  

16. 在 Eccentricity 輸入欄確認 ‘-8.1’ m 

17. 在 Impact Factor 輸入欄輸入 ‘0.173’ 

18. 在 Vehicular Load Distribution 輸入欄確認 ‘Cross Beam’ 

19. 在 Cross Beam Group 輸入欄確認 ‘cross Beam 2’ 

20. 在 Moving Direction 選擇欄確認 ‘Both’ 

21. 在 Selection 的 2 Points、Picking 及 Number 中選擇 ‘2 Points’，用滑

鼠點擊右側的輸入欄使其變為草綠色後，指定節點 1、11  

22. 點擊  鍵  

23. 點擊  鍵  

 

 

 車道為曲線或不連續

而不方便以2 Points來

輸入時可選擇Element 

Number，用鍵盤直接輸

入單元編號。  
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                圖21.  Traffic Line Lanes 對話視窗 
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接下來將說明定義車輛移動載重 HS20-44(MS18) 和 HS-20-44(MS18) 的方法。


 (參考圖22)  

 

1. 主選單 Load>Moving Load Analysis Data>Vehicles  

2. 在 Vehicles 對話視窗點擊  鍵  

3. 在 Standard Name 選擇欄確認 ‘Taiwan’  

4. 在 Vehicular Load Name 選擇欄確認 ‘HS20-44(MS18)’  

5. 點擊  鍵  

6. 在 Vehicular Name 選擇欄選擇 ‘HS-20-44(MS18)’ 

7. 點擊  鍵  

8. 點擊   鍵  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖22.  定義標準車輛載重 

  

 midas Civil 程式內

建有台灣公路橋樑載

重、AASHTO、中國公

路橋樑載重、中國城市

橋樑載重、中國鐵路橋

涵載重…等標準車輛載

重。 
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定義車輛載重群組。


 (參考圖23)  

 

 

1. 主選單 Load>Moving Load Analysis Data>Vehicles Classes  

2. 在 Vehicles Classes 對話視窗點擊  鍵  

3. 在 Vehicles Class Data 對話視窗的 Vehicles Class Name 輸入欄輸入 

‘HS20’ 

4. 選擇 Vehicle Load 項目中的 HS20-44(M18) 和 HS-20-44(M18) 後，點

擊  鍵將其移動到 Selected Load 項目 

5. 點擊 Vehicles Class Data 對話視窗的  鍵  

6. 點擊  鍵  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖23.  定義車輛載重組 

  

 利用Vehicle Classes

功能可定義車輛載重

組。若像本例題一樣將 

HS20-44(MS18)和HS-

20-44(MS18)載重定義

為相同車輛載重組的

話，可在兩種車輛載重

的分析結果中算出構件

內力、變形、反力等的

最大、最小值。 
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以下定義車輛移動載重條件。


 (參考圖24) 

 

1. 主選單 Load>Moving Load Analysis Data>Moving Load Cases 

2. 在 Moving Load Cases 對話視窗點擊  鍵  

3. 在 Moving Load Cases 對話視窗的 Load Case Name 輸入欄輸入‘MVL’ 

4. 保留在 Multiple Presence Factor 欄內‘Scale Factor’的預設數值 

5. 在 Sub-Load Cases 選擇欄點擊  鍵  

6. 在 Load Case Data 的 Vehicle Class 選擇欄確認 ‘VC:HS20’  

7. 在 Scale Factor 輸入欄確認 ‘1’  

8. 在 Min. Number of Loaded Lanes 輸入欄輸入 ‘1’  

9. 在 Max. Number of Loaded Lanes 輸入欄輸入 ‘2’ 

10. 選擇 Assign Lanes 的 List of Lanes 項目中的 ‘lane1, lane2’ 後，點擊

 鍵將其移動到 Selected Lane 

11. 在 Sub-Load Cases 對話視窗點擊  鍵  

12. 在 Moving Load Cases 對話視窗點擊  鍵  

13. 點擊  鍵  

 

 

  

  利用 Moving Load 

Case功能定義車輛載重

施加條件。其中包括在

哪條車道施加何種車輛

載重、可同時施加車輛

載重的最大、最小車道

數等。  
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圖 24.  定義車輛移動載重 
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下面將定義分析車輛移動載重的方法。(參考圖25.) 

 

1. 主選單 Analysis>Analysis Control>Moving Load   

2. 在 Analysis Method 選擇欄確認 ‘Exact’ 

3. 在 Load Point Selection 選擇欄確認 ‘All Points’ 

4. 在 Influence Generating Points 的 Number/Line Element 輸入 ‘5’ 

5. 在 Analysis Results 的 Frame 選擇 ‘Normal’ 

6. 在 Calculation Filters 將 Reactions, Displacements, Forces/Moments 等

均選擇確認為 ‘All’ 

7. 點擊  鍵  

8. 點擊  Node Number (切換 off) 

 

 

 

圖25.  Moving Load Analysis Control 對話視窗 
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進行結構分析 
 

對輸入載重條件和邊界條件的結構物進行結構分析。 

 

 

點擊  Analysis  

 

 
 

查看分析結果 
 

載重組合條件  

 

以下將介紹對結構分析的 3 種載重條件（靜載重、人行道載重、車輛移動載重）

進行線性組合(Linear Load Combination)的方法。 

 

在本例題中只輸入以下 1 種載重組合條件並對其結果進行確認。此載重組合是任

意設置的，僅供本例練習參考，與進行實際設計時所使用的條件無關。  

 

 載重組合條件 1(LCB1) : 1.0 (靜載重+人行道載重+MVL) 

 

 

  圖26.  Load Combinations 對話視窗 
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載重組合條件是在 主選單 的 Results>Load Combinations 開啟載重組合對話視窗，

並按以下步驟來輸入的。 

 

1. 主選單 選擇 Results>Load Combinations  

2. 在 Name 輸入欄輸入 ‘LCB1’  

3. 在 Type 選擇欄確認 ‘Add’  

4. 用滑鼠點擊 Load Case 選擇欄後，利用  鍵在選擇欄選擇‘Dead Load

(ST)’  

5. 在 Factor 輸入欄確認 ‘1.0’ 

6. 用滑鼠點擊第二個選擇欄後，利用  鍵在選擇欄選擇 ‘Sidewalk(ST)’  

7. 在 Factor 輸入欄確認 ‘1.0’ 

8. 用滑鼠點擊第三個選擇欄後，利用  鍵在選擇欄選擇 ‘MVL(MV)’ 

9. 在 Factor 輸入欄確認 ‘1.0’  

10. 點擊  鍵   
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查看變形 

 

按以下步驟確認變形狀況。  

 

1. 主選單 Results>Deformations>  Deformed Shape (圖27.的) 

2. 在 Load Cases/Combinations 選擇欄選擇 ‘CBmin:LCB1’ 

3. 在 Components 選擇欄確認 ‘DXYZ’   

4. 在 Type of Display 選擇欄對 ‘Undeformed’, ‘Legend’ 表示 ‘’ 標記 

5. 在 Type of Display 選擇欄點擊位於 Deform 右側的  鍵  

6. 在 Deformation Type 選擇欄選擇 ‘Real Deform’  

7. 確認 Apply upon OK 的 ‘’ 標記 

8. 點擊  鍵   

9. 點擊  Hidden (切換 on) 

 

 

 

圖27.  變形(Deformed Shape) 

 

 

 

 
 
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剪力圖與彎矩圖 

 

剪力圖與彎矩圖結果的查看方法基本相同，故在此只以查看彎矩圖為例進行說明。

另外此處介紹查看結構物某一部分的彎矩圖的結果。以X-Z平面為例介紹顯示該平

面彎矩圖的步驟。


  

 

 

1. 點擊  Hidden (切換 off) 

2. 點擊  Initial View 

3. 點擊  Select by Plane 

4. 在 Plane 表單選擇 ‘XZ Plane’  

5. 用滑鼠在X-Z平面選擇節點 1 (自動抓取 y=0) 

6. 點擊  鍵  

7. 點擊  Activate  

8. 點擊  Front View 

9. 主選單 Results>Forces>  Beam Diagrams (圖28的)  

10. 在 Load Cases/Combinations 選擇欄選擇 ‘MVall: MVL’


 

11. 在 Components 選擇欄確認 ‘My’  

12. 在 Display Options 選擇欄選擇 ‘5 Points’, ‘Line Fill’  

13. 在 Scale 輸入欄確認 ‘1.0’  

14. 在 Type of Display 選擇欄確認 ‘Legend’ 的 ‘’ 標記 

15. 點擊  鍵  

 

 

 

 

 

 

 

 

 

 

 

 

 實際工作中經常需

要對某一特定部位的分

析結果進行查看、分

析，此時可以利用  

Select by Plane 功能輸

出相應平面上的分析結

果。 

 MVmin : 車輛載重作

用於建築物時構件的

最小值 

Mvmax : 車輛載重作

用於建築物時構件的

最大值  
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                   圖28.  梁單元的彎矩圖 My (XZ 平面) 

  

 

 
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查看影響線結果 

 

首先來查看支承反力的影響線。下面是對支承B1 (節點1) 的結果。  

 

1. 點擊  Activate All 

2. 主選單 Results>Moving Load>Influ. Line>  Reactions (圖29的)  

3. 在 Line/Surface Lanes 選擇欄確認 ‘Lane 1’  

4. 在 Key Node 輸入欄確認 ‘1’  

5. 在 Scale Factor 輸入欄確認 ‘1.0’  

6. 在 Components 選擇欄確認 ‘FZ’  

7. 在 Type of Display 選擇欄確認 ‘Legend’ 

8. 點擊  鍵  

9. 點擊  Front View  

 

 

 

圖29.  對支承反力的影響線 

 

 

 

 

 

 
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對支承反力的影響線結果透過動畫來進行查看。  
 

1. 點擊  Iso View  

2. 在 Type of Display 選擇欄選擇 ‘Legend’, ‘Animate’    

3. 點擊  鍵  

4. 點擊  Record 鍵  (圖30.的) 

5. 查看結果後點擊  Close 鍵使其回到原來的畫面 (圖30.的) 

 

 

   

  

圖30.  對支承反力影響線的動畫處理畫面  

 

 
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如圖31. 查看變形狀況(Deflection)的影響線結果。  

 

 

1. 點擊  Front View  

2. 主選單 Result>Moving Load>Influ. Lines> Displacements (圖31)  

3. 在 Line/Surface Lanes 選擇欄確認 ‘Lane 1’ 

4. 在 Key Node 輸入欄輸入 ‘15’


 

5. 在 Scale Factor 輸入欄輸入 ‘2.0’ 

6. 在 Components 選擇欄選擇 ‘DZ’ 

7. 在 Type of Display 選擇欄確認 ‘Legend’ 

8. 點擊  鍵  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖31.  變形形狀的影響線 

  

 在Key Node/Elem

輸入欄也可利用滑鼠編

輯功能來選擇單元或節

點。  

  
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如圖32. 查看單元的彎矩的影響線。 

 

1. 主選單 Result>Moving Load>Influ. Lines>  Beam Forces/Moments  

(圖32.的)  

2. 在 Line/Surface Lanes 選擇欄確認 ‘Lane 1’ 

3. 在 Key Element 輸入欄輸入 ‘23’ 

4. 在 Scale Factor 輸入欄輸入 ‘2.0’ 

5. 在 Parts 選擇欄確認 ‘ i ’ 

6. 在 Components 選擇欄選擇 ‘My’ 

7. 在 Type of Display 選擇欄確認 ‘Legend’ 

8. 點擊  鍵  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖32. 彎矩的影響線 

 

  
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如圖33.利用 Moving Load Tracer 查看車輛移動所引起的的反力。

 

 

 

1. 點擊  Iso View 和  Initial View 

2. 點擊  Select Plane   

3. 在 Plane 表單選擇 ‘XY Plane’ 並輸入節點 1 (Z Position = 1) 

4. 點擊  鍵  

5. 點擊  Activate 

6. 主選單 Results>Moving Load>Moving Tracer>Reactions 

7. 在 Moving Load Cases 選擇欄選擇 ‘MVmax : MVL’  

8. 在 Key Node 輸入欄輸入 ‘1’  

9. 在 Scale Factor 輸入欄確認 ‘1.0’  

10. 在 Components 選擇欄確認 ‘FZ’  

11. 在 Type of Display 選擇欄確認 ‘Contour’, ‘Legend’, ‘Applied Loads’ 

12. 點擊  鍵  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖33.  利用 Moving Load Tracer 確認移動載重的施加位置 

  

 Moving Load Tracer

可在進行車輛移動載重

結構分析時對所得到的

結果予以使用。是根據

結果推算車輛的加載狀

態並將其以影響線(影響

面 )的形式來表現的功

能。   
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利用 Moving Load Tracer 查看車輛移動的位置，對梁單元 28 的 i 端點引起的移動

狀況。
 

 

 

1. 主選單 Results>Moving Load>Moving Tracer>Beam Forces/Moments 

2. 在 Moving Load Cases 選擇欄選擇 ‘MVmax : MVL’  

3. 在 Key Element 輸入欄輸入 ‘28’  

4. 在 Scale Factor 輸入欄確認 ‘1.0’  

5. 在 Parts 選擇欄確認 ‘ i ’ 

6. 在 Components 選擇欄確認 ‘My’  

7. 在 Type of Display 選擇欄確認 ‘Contour’, ‘Legend’, ‘Applied Loads’ 

8. 點擊  鍵  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖34.  利用 Moving Load Tracer 確認移動載重的施加位置 
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利用 Moving Load Tracer 查看車輛移動的位置後，可將移動活載重轉換為靜態載重

作進一步的結果驗證。 

點擊 Moving Load Tracer Function 中的  鍵將轉換的靜

態力資料儲存於 MCT 檔，再利用執行 MCT Command Shell 將此靜態力作用於模型

中。 

 

1. 點擊  

2. 在 Moving Load Converted to Static Load 對話框按  鍵存檔 

3. 由 File>Exit 離開關閉 MIDAS/Test Editor 文字編輯工具  

4. 主選單 Tools>MCT Command Shell 的  Open>File Name 開啟剛

所儲存的 ‘MVmaxMVLMy28.mct’ 檔案 

5. 按 MCT Command Shell 對話視窗的    

6. 當出現詢問 “Analysis/design results will be deleted; Continue?” 訊息視

窗時，按  鍵 

7. 按 MCT Command Shell 對話視窗的  

8. 主選單 Load>Static Loads>Static Load Cases 

9. 確認已加入由 Name 為 ‘MVmaxMVLMy28’ 的靜態載重狀況 

10. 點擊 Static Load Cases 對話框的  鍵  

11. 點擊  Analysis 
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                         圖35.  自動轉換動態力為靜態力 

例題 4 END 

 

 


